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This user guide provides instructions for installing, operating and maintaining 
J850/J835 3D printing systems. It explains how to use features, and provides 
practical examples to guide you as you use the system.

The text and figures in this guide are based on the J8 Series 3D printer, 
software version 85.2.0.

This guide assumes that—
• all the hardware, software, and network components of your  system are 

installed, configured, and operating correctly.
• the operator has a working knowledge of the Windows® PC platform.

Visit the Stratasys Support Center to download additional documents for this 
printer, including documents in other languages. Also available on this site: 
details about consumables and support contacts.

If you have any questions or comments about the way information is 
presented in this guide, or if you have any suggestions for future editions, 
please send a message to c-support@stratasys.com.



Build tray In the print preparation application: The surface displayed on the 
screen that represents the actual build tray in the printer.
In the printer: The surface upon which models are produced.

Cleaning fluid Cleanser for flushing material feed tubes and the printing block, used 
to completely remove Model and Support material from the system 
before loading another type of material in the printer and before 
long-term shutdown. The cleaning fluid is supplied in material 
cartridges.

Client/user 
workstation

The workstation on which  software is installed for preparing build 
trays for production on PolyJet printers. (There is no limit to the 
number of client workstations.)

GrabCAD 
Print

A software application for preparing print jobs on a variety of 3D 
printers, including J850/J835 printers.

Mixed part Models whose parts are printed using more than one model 
material.

Mixed tray A build tray containing objects, each of which is designed to be 
printed using a different model material.

Model 
material

Material used for building models.

Printer 
computer

The computer inside the J850/J835 printer that operates it.

Printer 
interface

The GUI (graphical user interface) used for controlling J850/J835 
printers.

Printer 
software, 
printer-
control 
application

Software running on the computer in the J850/J835 printer, 
controling all printer operations.

Resin The base substance from which photopolymer printing materials are made 
for use in Stratasys PolyJet printers.

STL A file used for printing 3D models.

Support 
material

Material used for supporting the structure of models during 
production.



2
Safety Features 2-2
Symbols and Warning Labels 2-3
Safety Guidelines 2-4

Printer Installation 2-4
Printer Operation 2-4
UV Radiation 2-4
Printer Maintenance 2-5
Model and Support Materials 2-5
UV Lamps 2-6

First Aid for Working with Printing Materials 2-7
Contact with Skin 2-7
Contact with Eyes 2-7
Ingestion 2-7
Inhalation 2-8

Waste Disposal 2-8



Stratasys 3D printers are designed to comply with CE and FCC 
standards. They are equipped with the following safety features:

Interlock Switch The power supplied to the UV lamp, the tray heater and the 
motion motors is turned off when the cover is opened.

Safety Lock The cover is locked while the printer is working. If you do 
manage to lift it, the UV lamps and the motion motors turn off.

UV Screening The transparent section of the cover blocks harmful UV 
radiation, allowing the operator to view models as they are 
being made.



Circuit Breaker The power to the printer is turned off in case of electrical 
overcurrent. 

Note: The circuit breaker is only accessible to service 
personnel.

UV-Lamp Overheating 
Protection

The power supplied to the UV lamp and the motion motors is
turned off if the temperature around the lamp reaches 90°C 
(194°F). A label on the UV-lamp cover indicates if the
temperature has exceeded 65°C (150°F).

Grounded Chassis The chassis of the printer is grounded, to prevent electrical 
shock.

Note: The power outlet must be properly grounded, in
accordance with the local electric code, to provide this 
protection.

This following table lists the warning labels located on or in the printer.



The following general guidelines, together with the instructions provided 
throughout this user guide, ensure user safety while operating and 
maintaining the system. If the system is not operated as specified, 
the user's safety may be compromised.

➢  Installation and removal of the printer should only be done by qualified 
service personnel. 

➢  Connect the printer (and the UPS unit) to the electric outlet using a power 
cord that is safety-certified.

➢  The electric outlet should be easily accessible, near the printer.

➢  Never connect the power plug to an outlet that does not have a ground 
(earth) wire, and never disconnect the ground. Doing so might expose the 
operator to serious danger from electric shock.

➢  The following safety statement is followed by translations to Finish, 
Norwegian, Swedish and Danish, as required by local regulations: 

“The machine must be connected to a grounded power outlet.” 

❒  FI: Laite on liitettävä suojakoskettimilla varustettuun pistorasiaan.
❒  NO: Apparatet må tilkoples jordet stikkontakt.
❒  SE: Apparaten skall anslutas till jordat uttag.
❒  DK: Apparatets stikprop skal tilsluttes en stikkontakt med jord, som 

giver forbindelse til stikproppens jord.

➢  For Japan: The power cable supplied is provided for connecting the 
printer to the AC electric source. Do not use it with other equipment.

➢  Leave a minimum of 15 centimeters (6 inches) between ventilation 
openings and walls or other objects.

➢  The printer should only be operated by persons trained by a Stratasys 
customer-support representative.

➢  All persons operating or maintaining the printer should know the location 
of first aid and emergency equipment and how to use it. Never block 
access to this equipment.

➢  Keep fingers and other body parts clear of the printer when closing the 
cover.

➢  Never attempt to open the printer while it is working.

➢  Never override the interlock safety switch.

➢  If the interlock safety switch ever fails, do not use the printer. 

➢  Several parts of the printer remain extremely hot even after it has stopped 
operating. Avoid touching the UV lamps and the print block. 

The UV lamps used in the printer emit dangerous radiation

➢  If the UV lamps remain on when the printer is open, do not stare directly 
at the UV light. Shut down the printer and call your Stratasys service 
provider.



➢  Service operations should be performed only by qualified personnel who 
have been instructed in relevant safety precautions.

➢  Notify co-workers and those who have access to the printer before 
beginning non-routine and hazardous work.

Model and Support materials are made of chemical substances. Although 
precautions must be taken when handling these materials directly, all Model 
and Support materials used by the printer are handled in sealed cartridges. 
Normally, operators of the printer should never be directly exposed to 
hazardous materials. In the unlikely event of a leak or spill, follow the 
instructions that are included with the material cartridges used.

➢  Store Model and Support materials indoors, in a dry area with adequate 
ventilation, between 15-25 degrees Celsius (59-77 degrees Fahrenheit). 
Never expose them to flames, heat, sparks, or direct sunlight.

➢  Keep Model and Support materials away from areas where food and drink 
are stored, prepared and consumed.

➢  Uncured printing material is considered a hazardous substance, requiring 
certain precautions when directly handling it. To prevent skin irritation, 
wear neoprene or nitrile gloves. If there is any chance that Model and 
Support materials might splash into the eyes, wear safety goggles. 
Prolonged direct contact with printing materials can cause an allergic 
reaction.

➢  When handling UV-cured models that may not be completely cured on the 
surface, common latex gloves are adequate. 

➢  To prevent respiratory irritation, ventilate areas where Model and Support 
materials are used. If the printer is not equipped with an exhaust duct, the 
room ventilation system should replace the air at least 20 times per hour.

➢  Clean up Model-material and Support-material spills with disposable 
towels or other absorbent, non-reusable material, such as sawdust or 
activated charcoal. Rinse the spill area with denatured or isopropyl alcohol 
(IPA), followed by soap and water. Dispose of the absorbent material in 
accordance with local regulations.

➢  Do not wash contaminated clothing at home; clothing should be 
professionally laundered.

➢  Dispose of contaminated shoes, belts and other leather items in 
accordance with any applicable regulations. Absorbed printing material 
may re-expose the user when these items are worn.



UV lamps used by the printer to cure printing materials contain a small 
amount of mercury. In the unlikely event of lamp breakage, avoid inhaling 
mercury vapor, and ventilate the room. If the lamp ruptures (breaks) during 
operation, leave the room and ventilate it thoroughly for about 30 minutes. 

Use protective gloves to prevent contact with mercury and other lamp 
components. Carefully remove spilled mercury with a method that prevents 
the generation of mercury vapor, such as a syringe, packing tape or paper. 

Place the broken lamp, mercury and contaminated materials in an air-tight, 
non-metallic container. Dispose of the container in accordance with 
applicable regulations.



In general, try to avoid direct contact with uncured printing material. If skin 
or eyes come into contact with it, wash the area immediately and thoroughly 
with water, and follow these first-aid instructions.

If uncured printing material comes in contact with skin, wash the affected 
area immediately and thoroughly with soap and cool water, then remove 
contaminated clothing. Pay particular attention to flushing the hair, ears, 
nose and other parts of the body that are not easily cleaned. 

➢  Use cool water to prevent skin pores from opening, so that the liquid 
material does not easily penetrate the skin. 

➢  Do not use solvents to clean skin. 

➢  If large areas of skin have been exposed, or if prolonged contact results in 
blisters, seek medical attention. In any case, if irritation persists, seek 
medical attention. 

➢  Avoid the accidental transfer of printing material from the hands to other 
areas of the body, especially to the eyes. 

➢  If protective cream was used, do not reapply it until the skin has been 
completely cleansed. 

If uncured printing material comes in contact with the eyes, flush 
immediately with large amounts of water for 15 minutes and seek medical 
attention. 

➢  Avoid sunlight, fluorescent light, and other sources of ultraviolet radiation.
 

Wearing contact lenses when handling liquid printing materials is not 
recommended. If the liquid splashes into the eyes when contact lenses are 
worn, immediately remove the lenses and flush the eyes with water. 

➢  Clean and disinfect the contaminated lenses. 

➢  Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the 
cartridge. Seek medical attention immediately.



Vapors from printing materials can be irritating to the respiratory system. If 
respiratory irritation occurs, expose the victim to fresh air immediately.

➢  If the victim has stopped breathing, perform artificial respiration or 
cardiopulmonary resuscitation. 

➢  Seek medical attention immediately.

➢  Keep the victim warm but not hot. 

➢  Never feed anything to an unconscious person.

➢  Oxygen should be administered by authorized personnel only.

Fully cured printed models can be disposed of as ordinary office trash. 
However, special care is required when handling printer waste (uncured 
printing material).

➢  When removing the waste container from the printer, wear neoprene or 
nitrile gloves.

➢  To prevent liquid waste from splashing into the eyes, wear safety goggles.

➢  Liquid waste from the printer is classified as hazardous industrial waste. 
Therefore, printing-material waste must be packaged and disposed of in a 
manner that prevents human contact with it and contamination of water 
sources.

➢  Empty Model-material and Support-material cartridges contain residue of 
their contents. Some leakage of this residue may occur through the broken 
cartridge seal. Therefore, handle and store empty cartridges with care. 

➢  Do not attempt to reuse empty cartridges, and do not puncture them.

➢  Dispose of used cartridges and waste containers in accordance with local 
regulations.

➢  Discard contaminated clothing, shoes, empty containers, etc., in 
accordance with any applicable regulations.

UV lamps used by the printer to cure printing materials contain a small 
amount of mercury, and are considered “Universal Waste.” Recycle or discard 
used lamps in accordance with applicable regulations.

Broken lamps: 
After ventilating the area, use protective gloves and carefully remove spilled 
mercury with a method that prevents the generation of mercury vapor, such 
as a syringe, packing tape or paper. Place the broken lamp, mercury and 
contaminated materials in an air-tight, non-metallic container. Dispose of the 
container in accordance with applicable regulations.
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J850/J835 printers offer the following options:
• You can streamline and economize the process of producing models.

❒  Printing models made from different materials on the same build tray 
(“mixed tray”), in the same print job, eliminates the time-consuming 
need and expense of loading another material, flushing the system, and 
sending a separate job to be printed.

❒  Alternating print jobs that use any of the Model materials (or material 
combinations) loaded similarly does not require material 
replacement—again, saving time and expense.

• You can print objects with combinations of basic materials (digital 
materials), enabling you to choose from a wide range of possible 
mechanical properties—from flexible to rigid. 

• You can print parts (shells) of the same model—simultaneously—with 
different materials (or material combinations)

• You can print objects that have a “coating” made from a different material 
than the main part of the object.

• You can mix any combination of base materials, resulting in an extremely 
wide range of available colors. 

• If you designate colors for parts of a model at the design stage (with CAD 
software) and save the model as a VRML file, the parts are automatically 
assigned appropriate material combinations in GrabCAD Print for printing 
the model with the desired colors.

• You can choose the preferred Support material for your needs.

GrabCAD Print supports many 3D CAD file formats, eliminating the need to 
convert them to STL files. GrabCAD Print also automatically repairs damaged 
files before sending them to the printer.



The Stratasys J8 Series 3D printing system can be set up as a single-station 
system or as a multi-station system. When connected to a local computer 
network, the system can serve multiple users. In such configurations, each 
user (client) prepares files  for production. A software service, installed on the 
printer computer, processes jobs and controls the printing.

Figure 3-1 shows the printer set up in a multi-client configuration.



J850/J835 printing systems produce three-dimensional models designed 
with most CAD tools and some other 3D applications. 

GrabCAD Print supports STL and, VRML files, and, in addition, native CAD 
formats from these programs: Creo, SOLIDWORKS, NX, CATIA and 
Inventor. To see the complete list of file formats supported by GrabCAD 
Print, go to: help.grabcad.com/print/file-formats.

J850/J835 systems feature the capability of producing different types of 
model files simultaneously.



J850/J835 printers produce models by jetting thin layers of printing 
materials on the build tray, until the complete model is formed. Two types of 
material are used in this process:

• Model material—which makes up the finished model
• Support material—which fills gaps and spaces in the model during 

printing, and is removed after printing

Materials used for printing models with J850/J835 printers are made of 
resins, which are composed of reactive monomers and oligomers. Although 
printing materials are supplied in sealed, UV-proof cartridges, care must be 
taken when storing and handling them. Follow these guidelines to protect 
operators and the environment, and to ensure optimum results. 

• To ensure product stability, do not allow these materials to come into 
contact with metal. Plastics made from monomer-soluble substances (such 
as polystyrene or polyvinyl chloride) are not suitable for storing PolyJet 
printing materials.

• When not in use, keep material cartridges tightly sealed to prevent 
contamination, the effects of exposure to UV radiation, and accidental 
spillage.

• Store material cartridges indoors, in a dry area with adequate ventilation, 
between 15–25 degrees Celsius (59-77 degrees Fahrenheit). If exposed to 
heat or flames, cartridges might burst or ignite.

• Signs of premature polymerization in material cartridges include bulging, 
leaking, the emission of heat, and unusual odor. Exposure to heat can 
cause resin to gel in the cartridges.

• Make sure that material cartridges are stored in accordance with all local 
regulations and other applicable requirements.

Materials used for producing models have a limited shelf life. The expiry date 
on the label is valid when properly stored in an undamaged, unopened 
cartridge. Always rotate your stock, so that the cartridge with the earliest date 
is used first.

If printing materials are not in their sealed cartridges, make sure to shield 
them from sunlight and other sources of UV radiation, such as fluorescent 
and mercury-vapor lights. Exposure to UV radiation causes an increase in 
viscosity and, eventually, solidification.



Before being cured, resins are hazardous materials. To prevent possible health 
hazards, follow these precautions regarding printing materials: 

• Do not expose to flames, heat or sparks.
• Prevent contact with skin and eyes.
• Ventilate areas where they are handled. 
• Keep them separate from food and drink.

Cured plastic parts, however, are safe. They can be handled and stored 
without precautions.





Dispose of cartridges of model and support material in accordance with all 
applicable laws and regulations. 

Extreme heat and humidity conditions can adversely affect the operation of 
your J850/J835 3D printer. Use ventilation or air-conditioning systems, if 
necessary, to keep the work area within the following ranges:

• 18°–25° C (64°–77° F)
• 30%–70% relative humidity

GrabCAD Print is an application for preparing and and managing print jobs 
on Stratasys J850/J835 printers (and on other supported 3D printers). To 
download GrabCAD Print, go to: help.grabcad.com/print/sign-up. 

To see the requirements for client computers running GrabCAD Print, go to: 
help.grabcad.com/print/system-requirements.

In addition to GrabCAD Print on client computers, GrabCAD PolyJet Server 
is required on the printer computer. This is the program that controls the 
actual printing. To download GrabCAD PolyJet Server, go to: 
help.grabcad.com/print/polyjet. 
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



1. Turn on the main power switch, located at the back of the printer.



2. After the printer-control computer boots, log in to Windows and launch 
the printer-control program:

All monitoring and controlling of the printer is done from this interface.

 



In High Mix / High Quality mode, J850/J835 printers use up to 14 cartridges 
of Model material and two cartridges of Support material, each weighing 4 
kilograms when full. In Super High Speed mode, you can use four cartridges 
of Model material and four cartridges of Support material.  A graphical 
representation of the cartridges loaded and their current weight appears in 
the printer interface (see the figure on the previous page).

1. Open the doors of the material cabinet.

2. Load Model and Support cartridges into their respective compartments.

You should feel some resistance, as a needle pierces the cartridge. 

3. Check the printer interface to make sure that the new cartridge is detected 
and that its weight is displayed (see the figure on the previous page).

4. Close the material cabinet.













Models can be printed after they are arranged on a virtual build tray in the 
GrabCAD Print application. For information about preparing model files for 
printing, see the GrabCAD Print online documentation.

Before beginning to produce models, it is recommended that you check the 
current printing quality of the print heads by performing a pattern test (see 
"Pattern Test" on page 4-31).

1. Make sure that the build tray in the printer is empty and clean. If not, 
remove cured material with the scraper, and clean the tray thoroughly 
with a wet cleaning cloth.

2. Make sure that there is sufficient Model and Support material loaded, as 
indicated on the printer interface (see the figure on page 4-4). You may 
want to replace the cartridges of Model and Support material currently 
loaded in the printer to avoid the need for replacing them during printing.



You can monitor printer status by switching the printer interface display. To 
do this, click the display toggle button on the printer interface screen.

➢  On the printer interface, click the red button to switch the printer to 
online mode.

The color of the button changes from red to green (see the figure on 
page 4-4).  If there is a job in the printing queue, it is sent to the printer.

In the printer interface, the printer mode changes from Idle to Pre-print, as 
the printer’s components prepare themselves for production: 

• The print block is heated.
• The UV lamps are powered and they warm up.

Depending on the size of the model(s) to be produced, printing can take 
between several hours to several days. As long as there is enough Model and 
Support material in the supply cartridges, printing proceeds automatically 
until the job is finished.

The J850/J835 printer uses up to seven different Model-material cartridges 
to produce models. In addition, a Support-material cartridge is required. If 
additional cartridges are installed and they are not immediately needed for 



printing, the printer interface indicates this (see "Printer Interface Color Key" 
below).

The background colors in the printer indicator fields tell you at a glance 
whether or not the value or item is suitable or ready for printing. 

• Green—suitable/ready for printing

For example, in Figure 4-4 on the previous page:

❒  Heads (°C)—The heads have reached the temperature required for 
printing models.

❒  Ambient—The ambient temperature of the printing chamber is within 
the acceptable range.

❒  Heads Liquid—The level of Model and Support material in the 
print-block reservoir is OK.

❒  Heads Vacuum—The vacuum level in the system is within the 
acceptable range.

❒  Pre-Heater—The Model and Support resins need to be heated before 
being supplied to the print block. The temperature has reached the 
acceptable range.

• Red—not suitable for printing (or indicates a warning)

For example, in Figure 4-4 on the previous page:

❒  Waste—The weight of the waste container is 9000 grams, more than 
allowed when beginning a print job. (See "Replacing the Waste 
Container" on page 4-97.)

• Blue—not ready

For example, in Figure 4-4 on the previous page:

❒  UV lamps—The UV lamps are not on.

The color of the material cartridges displayed in the printer interface indicates 
which cartridges are active for the current (or next) print job.

For example, in Figure 4-3 on page 4-4:
• Blue—active cartridge
• Gray—reserve cartridge



The printer interface screen changes when you send a print job to the printer, 
if the printer is on line:

• The mode changes from Pre-print to Printing. 
• The specific activity being performed is shown in the “current activity” 

field. 
• Current job-printing information is displayed.
• The printing progress bar is displayed.
• The Stop and Pause buttons are enabled.

When the weight of a cartridge drops below 100 grams, the display of the 
material level in the printer interface is red. 



If the printing process is interrupted, the print manager stops sending slices 
to the printer. This can happen, for example, if the printing material runs out 
in the middle of a print job, and you do not replace the empty cartridge 
immediately.  After the printer changes to Standby or Idle mode, you need to 
resume printing from the print manager in GrabCAD Print.

1. If the printer is in offline mode, switch it to online mode by clicking the 
red button at the bottom of the printer interface (see the figure on page 4-
4).

The button changes from red to green.

2. If you don’t know why printing has stopped, make sure that the 
connection between the printer and the server computer is active.

3. In the Schedule screen of GrabCAD Print:

❒  Click on the job to display the Job Status details, and click the Resume  

icon . 

OR—

❒  Right-click on the job to display the pop-up menu, and select
.



4. In the job-preparation application, make sure that the correct slice
number is entered in the  dialog box.

 

5. If, for any reason, the correct number does not appear in the dialog box, 
enter the number and click .

You cannot continue printing the model if:
• The number of the last slice printed does not appear in the printer 

interface, even if the server computer displays the  confirmation dialog box.
• There was a relatively long interruption in printing, even if the “last slice” 

and  indicators are correct. The part of the model already printed may
deform or shrink, and there might be a visible difference between it and 
the newly printed part. The effects of a printing stoppage on a model
depend on the model size and structure, Model material used, ambient
temperature and the length of the stoppage.



1. Cancel the job in GrabCAD Print.

In the Schedule screen: 

❒  Right-click on the job to display the pop-up menu, and select
.

OR—

❒  Left-click on the job to display the Job Status details, and click the

Cancel icon .

2. Remove the partially printed model from the build tray.

3. Click to resend the job to the printer.



Before producing models using a different type of printing material than is 
currently installed, run the Material Replacement wizard to flush the print 
block and feed tubes.

1. Start the Material Replacement wizard from the Options menu.

2. In the opening screen, click .

3. If the printer cover is not closed, a screen appears, prompting you to close 
the cover. Confirm that it is closed and click .



4. Choose the configuration for producing models:

❒  7 Materials (High Mix / High Quality)

❒  3 Materials (High Speed)

❒  Single Material (Super High Speed)

7 Materials

Each print head is loaded with two different materials. 

You can print with any single material, or with a combination of them. 
High-speed printing is not available, but high-quality models can be 
printed.



3 Materials

Both sections of each print head are loaded with  the same material.

 

Up to three Model materials are available, with high-speed printing.

Single Material

Both sections of two print heads are loaded with  the same Model 
material—DraftGrey (RGD750).
Both sections of two print heads are loaded with Support material.

 

This mode produces build trays with DraftGrey material, in Super High
Speed mode, at a layer resolution of 55 microns.

5. In the Required materials section of the wizard screen, select one or more
replacement materials cartridges.

6. For Model materials, select  if you need to load two replacement 
cartridges.

Loading one replacement cartridge is more economical because it
potentially requires less flushing of material currently in the system.
However, when one cartridge is not sufficient, loading two cartridges 
enables continuous printing until the print job is completed. When one 
cartridge empties and the other one is being used, you can replace the
empty cartridge with a new one.



7. For Support material, select  the number of cartridges to replace.

❒  In High Mix / High Quality and High Speed modes, you can print 
using one or two Support cartridges.

❒  In Super High Speed mode, at least two Support cartridges are 
required; you can print with up to four Support cartridges.

8. If the color or mechanical properties of the first printed models are 
unimportant, and if you did not change the printing mode (High 
Quality/Speed) you can replace the Model materials without flushing out 
the current materials. To do so, continue with  "Changing Model Materials 
Without Flushing" on page 4-18.

9. To flush out material currently in the system, choose the flushing cycle 
that fits your needs:

❒  Economy. This cycle can be used when replacing a light-colored Model 
material with a darker material (such as TangoBlack™ or VeroBlack™) 
or if the exact color of the printed models is unimportant. Use this 
cycle when replacing cleaning fluid with any Model material.

The wizard flushes the system with the minimum amount of material 
needed to ensure that models have the mechanical properties of the 
new material.

❒  Full. Use this cycle when the printed models must have the exact color 
of the new material.

The wizard thoroughly flushes  the feed tubes and print heads needed 
for printing, based on your selections in the previous screens. 



10. Click to begin the material replacement process in the printer.

The Cartridge Positioning screen appears, showing you the new location
of all cartridges in the material cabinet.

 The correct cartridge is in this slot.

 No cartridge (or the incorrect cartridge) is in this slot.

 The cartridge in this slot has insufficient weight to complete the material 
replacement process.

 The expiration date of the cartridge in this slot has passed.

11. Replace material cartridges as necessary, according to the instructions in 
the wizard screen.

12. Click .

13. Read the warning message, and click .

14. In the final wizard screen, click .

The printer-control application is automatically updated, and it restarts. 
When it opens, the interface displays the new material(s).  The interface in



the job preparation application  is also updated, and it displays the new 
material(s).

15. Inspect the area around the purge unit and clean it, if necessary.

If you do not change the printing mode (High Quality/Speed) you can replace 
the Model materials without flushing out the current materials. Use this 
option when the color or mechanical properties of the printed model are 
unimportant.

1. In the Material Replacement Options screen, click .

2. In the Advanced Settings screen, select  and click 
.

 



3. When the Material Replacement Options screen opens, select the Replace 
materials without flushing check box and click .

4. In the confirmation message that appears, click  to continue. 

 



5. In the Cartridge Positioning and Process Progression screen, click .

 

6. Read the Warning message that appears, and click  to continue.

 

Material replacement begins.

The Advanced Settings dialog box enables you to configure the Material 
Replacement wizard for special purposes. If necessary, click 

 in the Material Replacement Options screen before clicking .

By default, Automatic slot selection determines the best slot locations for the 
cartridges in the material cabinet, based on materials currently in the system. 
This ensures minimum flushing of materials currently loaded.

Select —             
• if there is a special need to load cartridges in certain slot locations.             
• if you only want to change one of the cartridges in certain locations.



1. In the Material Replacement Options screen, click .

2. In the Advanced Settings screen, select , and click 
.

 

3. In the Material Replacement Options screen,  is selected 
for each position. To print with only one of the cartridges, clear the check 
box  and then select either the left ( ) or the right ( ) cartridge.



When printing in High Speed mode (three materials), the same material is 
used in both sections of each print head. The material selected for one of 
the cartridge slots is also used in the other print head channel.

4. After selecting the materials for the appropriate cartridge slots, the 
Cartridge Positioning screen appears. Place the cartridges in the materials 
cabinet as shown in this screen.



The flushing cycle you select in the Material Replacement Options screen 
determines how thoroughly to flush out material currently in the system. 
After selecting the Economy cycle and completing the wizard, you might 
decide that you require a more thorough flushing, to ensure accurate model 
color. Or, you may notice that printed models are not satisfactory because 
they contain traces of the previous material. If so, you can flush out more 
material, so that the next models will be printed with pure material.

➢  In the Advanced Settings screen, select  and 
click .

 

The Material Replacement Options screen appears, where you can select the 
material(s) you need to flush again.



Between printing jobs, the printer can be left unused for up to one week. If 
the printer will not be used for more than a week, use the Shutdown wizard 
to automatically perform the procedures that must be done before turning off 
the printer (see "Shutting Down the Printer" on the next page).

When the printer stops producing models, the printer software automatically 
reduces the temperature of the print heads, as follows:

If, after printing a job, you know that the printer will not be used for 16 
minutes or more, you can immediately turn off the heating of the print heads 
by putting the printer into Idle mode.

➢  From the File menu (in the printer interface) click .



You only need to shut down the printer if it will not be used for a week or 
more. Otherwise, the printer can remain on, in Idle mode. 

To properly shut down, the printer needs to perform several processes. These 
are controlled by the Shutdown wizard. Do not attempt to shut down 
the printer by simply closing the computer interface (the printer-
control application), and never disconnect power to the printer 
before completing this wizard.

Depending on the length of time the printer will not be used, you can choose 
between a short shutdown procedure, and a more thorough procedure.

• Up to 30 days: The wizard empties the print block of Model and 
Support material, to prevent leaks. This takes about 10 minutes.

• More than 30 days: The wizard empties the print block, then flushes 
the system with cleaning fluid. This takes up to 75 minutes, and you must 
be present to load a cleaning-fluid cartridge when instructed. 

1. Start the Shutdown wizard from the Options menu.

2. Click .



3. Select the option corresponding to the length of time that the printer will 
not be used—less or more than 30 days.

4. In the next screen, verify that the tray is empty and click .             

The shutdown procedure begins.



5. Follow the instructions until cleaning is completed.

6. When the final wizard screen appears, close the printer-control 
application and shut down the printer computer.

7. After the printer computer shuts down, turn off the main power switch at 
the back of the printer  (see Figure 4-2 on page 4-4).



Performing routine maintenance tasks is essential for getting satisfactory 
results from J850/J835 printers. Perform the tasks at specified intervals.



 

The printer computer application records the dates and frequency for each 
maintenance task. You can display the Maintenance Counters screen from 
the Options menu.



If there is a maintenance task due, this is indicated on the main interface 
screen.

 

If this indicator appears, you can display the Maintenance Counters screen by 
clicking on it.

 

For maintenance tasks that are controlled by wizards, the dates and printing 
times are reset automatically when the relevant wizard is run and completed 
successfully. Manual maintenance tasks (for example, roller inspection and 
wiper replacement) are reset by clicking the reset button in the Maintenance 
Counters screen.



A heat-sensitive label is fixed to the UV lamp covers as a warning against 
overheating. Its center changes from white to black if the temperature of the
cover reaches 65°C (150°F). If this occurs, do not use the printer, and call 
your service provider. As a precaution, it is recommended that you check the 
label before and after printing. 

The pattern test is the basic verification of the printer’s ability to produce 
quality models, since it demonstrates the condition of the nozzles in the print 
heads. Make sure, therefore, that you perform this test weekly, and whenever
you suspect a printing problem.

1. Make sure that the build tray is empty.

2. Prepare a sheet of pink paper, A-4 or Letter size.

3. In the printer, tape the pink paper to the surface left of the build tray.

4. Press , or open the Options menu and select .



5. Click  in the Confirm dialog box to begin.

6. If the build tray is not clear, click  in the following dialog box.

This lowers the build tray, so that models on the tray are not damaged.



The printer prints a series of lines on the test paper (see next figure).

7. Carefully inspect the test paper to see if there are missing lines. 

Too many missing lines, especially if they are in the same area, indicates 
that the quality of printing when producing models will be poor. If this is 
the case, see "Improving Print Quality" on the next page.



It is recommended that you periodically back up the printer's configuration 
files. In case of printer malfunction or the need to re-install the software on 
the printer computer, parameters can be restored from the backup. The 
backup also saves the printer's log and the calibration and maintenance 
history.

1. From the Options menu, select .

or—

Press .

2. In the confirmation dialog box, click .

A zip file is saved in this folder—
\STRATASYS_J8_SERIES\ServiceData

3. Copy this file to a location that is not on the printer computer (for 
example, a network folder or a USB drive).

If you suspect that print quality is poor, perform the Pattern Test (see 
"Pattern Test" on page 4-31). If the results are poor, use the following 
procedure to improve print quality.

1. From the Options menu, select , or press .

2. In the confirmation dialog box, click .

The print heads are purged of Model and Support material, and the wiper 
removes excess material from them.

3. Repeat the purge sequence.

4. Perform the pattern test.

1. Manually clean the print heads (see "Cleaning the Print Heads, Roller and 
Wiper" on the next page).

2. Perform the purge sequence.

3. Perform the pattern test.



1. Carefully clean the print heads again, making sure there is no residue left 
on them.

2. Perform the purge sequence.

3. Perform the pattern test.

➢  Optimize the print heads and replace faulty print heads, if necessary (see 
"Optimizing (Calibrating) Print Heads" on page 4-51).

Regular inspection and cleaning of the orifice plates on the bottom of the 
print heads prevents print nozzles from clogging. Cleaning the roller and 
wiper are also important for maintaining quality printing. A wizard adjusts 
printer components to enable access to these key areas, and it guides you 
through the cleaning procedure. To maintain the printer in optimum 
condition, run the wizard after every print job, when you remove the model 
from the build tray. This procedure takes about 20 minutes.

1. Prepare—

❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

❒  disposable cleaning gloves 

❒  a supplied cleaning cloth or equivalent 

❒  a mirror

2. Start the Cleaning wizard from the Options menu.



3. Make sure that the build tray is clear (empty), and close the cover. 
Confirm this in the wizard screen and click .

The printer moves components to the cleaning position.

4. When the following screen appears, open the printer.

5. Place the mirror on the build tray. 

6. Put on the gloves.

7. Soak the cleaning cloth with alcohol.



8. Clean the orifice plates, with a back-and-forth motion. Use the mirror to 
make sure that you have removed all of the residue material.

9. After cleaning the print heads, clean the entire roller surface, by rotating it 
as you clean. 

10. Clean the glass lens on the UV lamps. 

11. Using a generous amount of alcohol on the cleaning cloth, remove any 
material remaining on the wiper and the surrounding area. 

12. Remove any pieces of waste material collected in the purge unit. If 
necessary, remove the waste collector to clean it. Wipe the rubber seal.

 



13. Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it 
completely, replace it.

a. Grasp it and pull it up and out of its bracket. 
b. Insert the new wiper blade, making sure that it is straight and secured 

well on both sides. 

14. When you have finished cleaning, select the confirmation check boxes in 
the wizard screen (see Figure 4-40) and click .

15. Remove the cleaning materials from the printer and close the printer 
cover.

16. Select the confirmation check boxes in the wizard screen and click .

The head-purge cycle begins. When this is complete, the final wizard 
screen appears.

17. Click to close the wizard.

The roller waste collector removes waste material scraped from the roller. 
Suction removes this waste to the printer’s waste container.

This assembly should be cleaned weekly to prevent a blockage in the tubes 
leading to the waste container, so that waste material does not overflow into 
the printer.

1. Prepare—

❒  M2.5 and M2 Hex (Allen) keys

❒  disposable cleaning gloves

❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

❒  cleaning cloth

❒  cotton swabs (Q-tips or similar)

2. Put on the gloves.



3. Remove the right UV-lamp assembly:

a. Disconnect the UV power cable and the fan power cable.

b. Remove the screw that secures the right UV lamp, and then pull and 
lift up the UV lamp.

4. Loosen the two screws securing the suction tube on the print block.

5. Lift the suction tube to secure it in a raised position.



6. Remove the two screws securing the covering of the roller waste collector 
and remove it.

7. Remove the covering by pulling it out, and then lower it.

8. Clean the roller waste collector and the scraper blade surface using cotton 
swabs. Make sure to remove any remaining printing materials.

—

1. Put on the cleaning gloves.

2. Wet a cloth with isopropanol.

3. Use the cloth to wet the bottom of the roller.

4. Turn the roller slowly with your hand. As the blade scrapes the roller, 
make sure the isopropanol is spread evenly over the entire length of the 
blade.

5. Inspect the roller. If it is not dry, replace the blade. (See "Replacing the 
Roller Scraper" on the next page.)



6. Before returning the roller waste collector to the print block, make sure 
that the pins are clean. 

1. Return the roller waste collector to the print block and screw on the 
covering (see Figure 4-46 on the previous page).

2. Loosen the screws securing the suction tube.

3. Lower the suction tube so that the hole in the panel behind the tube is 
visible, and tighten the screws to secure the tube. 

4. Attach the right-UV-lamp assembly to the print block and reconnect the 
UV power and fan cables.

You should replace the roller scraper blade—
• after 1,000 hours of printing.
• if it does not effectively keep the roller clean.



1. Prepare—

❒  a new roller scraper blade

❒  a Phillips 1x75 mm screwdriver

❒  a 2.5-mm and a 2-mm hex (Allen) key

2. Remove the right UV lamp and the roller waste collector covering (see 
steps 3 to 6  on page 4-39).

3. Loosen the two screws securing the roller waste collector and pull it out.

4. Remove the screws that secure the roller scraper assembly. 

5. Remove the scraper blade and discard it.



6. Place the new scraper blade onto the pins in the holder, as shown. 



7. Insert and tighten the roller scraper blade screws.





8. After tightening the screws, inspect the blade and make sure that it is 
straight. If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to the 
print block. (See steps 4 to 6 on page 4-39 in "Cleaning the Roller Waste 
Collector and Inspecting the Roller Scraper".)

You should check the alignment of the print heads— 
• once a month
• after replacing one or more heads
• if model quality is not acceptable even after cleaning the orifice plate on 

the bottom of the print block (see "Cleaning the Print Heads, Roller and 
Wiper" on page 4-35).

This procedure takes about 20 minutes.

1. Prepare—

❒  a transparency sheet, A-4 or Letter size

❒  any type of adhesive tape, to fasten the transparency sheet to the build 
tray

2. Start the Head Alignment wizard from the Options menu.

3. Close the cover and click  to begin.



4. When the following screen appears, place the transparency on the build 
tray—next to the left and rear edges of the tray (see below).

5. Make sure that the transparency sheet is lying flat, and tape it to the tray.

6. Close the printer.

7. In the wizard screen, select the check box to confirm that the 
transparency sheet is on the build tray, and click .

8. If the printer is currently loaded with seven materials, (High Mix / 
High Quality mode), select the mode for aligning the print heads.



When you click , the printer prints the head alignment test on the 
transparency. When printing is finished, the following screen appears.

9. Open the printer and remove the transparency.

The transparency sheet is printed with sets of vertical lines in seven 
columns, each showing the results from a different print head.



10. For each column of lines, use a magnifying glass or loupe to inspect pairs 
of consecutive rows printed on the transparency to see where the vertical 
lines align.

Optimum head alignment is shown when the fourth lines in the upper and 
lower rows are aligned, as in Figure 4-60. In the example shown, no 
change to the head alignment is necessary. If other lines in the set are 
aligned, you need to change the alignment of that head—in the next 
wizard screens.

11. In the wizard screen shown in Figure 4-58, select the Transparency 
removed check box, and click .

The first in a series of alignment screens appears.

12. In the head-alignment screen, select the number that indicates which 
lines align in the upper and lower rows of a pair on the transparency 
(counting from the left) for this print head.



13. Click  to display the next head alignment screen, and again select the 
number representing the most closely aligned vertical lines on the 
transparency for that print head.

When you have finished aligning all of the heads, the following screen is 
displayed.

14. Continue as follows:

❒  To make the alignment changes in the printer, make sure that Update 
system with new parameters is selected, and click .

❒  To recheck the alignment test results before making the alignment 
changes in the printer, click .

❒  If you do not want to make alignment changes in the printer at this 
time, select Keep previous parameters, and click .

15. In the following screen, you can choose to either repeat the head 
alignment procedure or close the wizard. 

❒  If the most closely aligned vertical lines for a print head were at either 
extreme, choose Repeat the test, then click . 

The transparency test will show if the heads are now properly aligned, 
and—if not—the wizard will allow you to “fine tune” the alignment.



❒  If the vertical lines for the print heads were not aligned at either 
extreme, choose End the wizard, then click .

 

To prevent excess printing material from accumulating around the print 
heads, a splash shield is installed on the bottom of the print block. Remove 
the shield and clean it once a month, when cleaning the print heads (see 
"Cleaning the Print Heads, Roller and Wiper" on page 4-35).

1. Run the Cleaning wizard from the Options menu.

When the printer moves components to the cleaning position, the 
following screen appears.

2. Open the printer and place a mirror on the build tray.

3. Put on cleaning gloves.



4. Using a 2-mm hex (Allen) key, remove the screws to remove the splash 
shield.

5. Soak a cleaning cloth with 90% alcohol and clean the splash shield.

6. Return the splash shield to the print block and secure it with four (4) 
screws.



The condition of the print heads directly affects the quality of printed models. 
To maintain optimum printing, you should routinely test the print heads, and 
calibrate them to the best working configuration possible by running the 
Head Optimization wizard every 300 hours of printing. You also need to 
calibrate the print heads after changing the printing mode between 
High Mix / High Quality and one of the high-speed modes.

During this procedure, you place a scale on the build tray and connect it to 
the printer. Printing material (resin) is jetted from each head and its weight is 
automatically recorded and the wizard determines how to optimize the print 
heads. 

If, during the optimization process, the wizard determines that a print head is 
faulty—or that it is negatively affecting layer uniformity with the current head 
configuration—the wizard instructs you to replace it. If this happens, you can 
continue the wizard to replace the print head, or abort the wizard, to replace 
the head at another time. 

Note: To accurately test and calibrate print heads, they must be clean. If 
necessary, run the Cleaning wizard before beginning this procedure.

1. Prepare—

❒  disposable cleaning gloves (any clean, powder-free protective gloves)

❒  pink paper

❒  the Missing Nozzles ruler

❒  the scale supplied for use in the Head Optimization wizard

Important:  Ensure that the scale is calibrated before beginning this 
procedure. 



2. Start the Head Optimization wizard from the Options menu.

3. In the opening wizard screen, click  to begin.

The Wizard Conditions screen appears.

4. Read the conditions, select  and click .

5. In the following screen, select  if you have 
recently cleaned the print heads. Otherwise, cancel the wizard and run the 
Cleaning wizard.



6. In the following screen, make sure Optimize all print heads is selected, 
and click .

7. Select the printing mode for which you want to optimize the print heads 
and click .



8. When the following screen appears, tape a sheet of pink paper to the 
surface left of the build tray, close the cover and click .

The printer prints a frame on the build tray and then prints the Pattern 
Test on the pink paper.

9. When the Pattern Test is printed, carefully inspect it, using the Missing 
Nozzles Ruler to see if there are missing lines.

Each missing line represents a faulty nozzle in the print head.



10. In the following wizard screen, enter the number of missing nozzles for 
each print head and click .

11. The wizard continues according to the number of missing nozzles you 
entered. 

❒  If there are too many missing nozzles for acceptable printing, the 
wizard instructs you to replace the defective print head(s). You can do 
this now, or abort the wizard.

If you are prepared to replace print heads now, the wizard guides you 
through the procedure when you click . Make sure you have 
replacement heads and the required tools (see page 4-60). Then, 
continue with "Preparing the Print Block" on page 4-61.

❒  If the number of missing nozzles in all print heads is acceptable, the 
wizard continues with the head optimization process (below).



12. Set up the scale in the printer by performing the steps listed in the wizard 
screen.

13. After confirming all of the items listed in the wizard screen, click .

Printing material (resin) is jetted from each head and its weight is 
automatically recorded. This process is repeated for each printing mode, 
after which the following screen appears.

14. Carefully remove the resin container from the scale and empty it into the 
purge unit in the printer. Then return the container to the scale.





15. Close the printer and click .

The printer cures the remaining resin in the container.



16. When the following screen appears, remove the scale and clean the build 
tray. 

17. In the wizard screen, confirm that the build tray is clear and that the 
cover is closed, and click .

The wizard uses the data collected to analyze the condition of the print 
heads and optimize them so they print models with a uniform layer of 
material. 

❒  If the heads are in satisfactory condition, the following wizard screen 
appears.



❒  If the wizard determines that a print head is faulty—or that it is 
negatively affecting model quality with the current head 
configuration—you need to replace it. Indicate whether or not you 
want to do so now.

• Select  if you are prepared to replace the 
print heads now (see below). 

or—

• Select  if you want to replace the print heads at 
another time.

❒  replacement print head(s)

❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

❒  disposable cleaning gloves (supplied with the print head; or use any 
clean, powder-free protective gloves)

❒  a supplied cleaning cloth or equivalent

❒  a mirror

❒  a 3-mm hex (Allen) key

❒  a small Phillips screwdriver

❒  the scale supplied for use in the Head Optimization wizard (Weight 
Test)

❒  the Missing Nozzles ruler

If you are replacing print heads now, the wizard guides you through the 
procedure when you click . Continue with "Replacing Print Heads" on 
the next page.



The condition of the print heads directly affects the quality of printed models. 
You may need to replace a print head if one or more of the following 
symptoms occurs:

• The Head Optimization wizard determines that a print head is defective. 
(See "Optimizing (Calibrating) Print Heads" on page 4-51.)

• There are noticeable grooves in the surface of printed models.
• Visual inspection of the head reveals that its surface is damaged—peeling 

or bubbles in the nozzle area.
• The printer interface displays a warning or malfunction message relating 

to a print head—
❒  Head Heater temperature timeout
❒  Head Heater thermistor open
❒  Head Heater thermistor short

The Head Optimization wizard guides you through the procedure of replacing 
a print head, and configures printer components to enable you to perform it. 
Only replace a print head with the aid of the wizard.

The entire print-head replacement procedure takes about 45 minutes, and 
consists of the following phases: 
A. Identifying the head(s) needing replacement. 

This is normally done by the Head Optimization wizard. Otherwise, 
evidence of physical damage to the head surface or a malfunction message 
indicates which head needs replacing.

B. Preparing the print block for head replacement.

This is done automatically when you run the wizard.

C. Removing the defective print head. 
D. Installing a new print head.
E. Optimizing the print heads (done automatically by the wizard).
F. Performing head alignment.        

 



1. Prepare—
❒  replacement print head(s)

❒  90% isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

❒  disposable cleaning gloves (supplied with the print head; or use any 
clean, powder-free protective gloves)

❒  a supplied cleaning cloth or equivalent

❒  a mirror

❒  a 3-mm hex (Allen) key

❒  the scale supplied for use in the Head Optimization wizard (Weight 
Test)

❒  the Missing Nozzles ruler

2. Start the Head Optimization wizard from the Options menu (see the figure 
on page 4-52).

3. In the opening wizard screen, click  to begin.

The Wizard Conditions screen appears.

4. Read the conditions, select  and click .
5. In the following screen, select  if you have 

recently cleaned the print heads. Otherwise, cancel the wizard and run the 
Head Cleaning wizard.



6. In the following screen, select , and click .

7. Select the print head(s) needing replacement, and click .

The printer heats and empties the print block, and prepares the printer. 
(This should take up to 15 minutes.)

The following screen appears when the printer is ready for you to replace 
print heads.

8. Put on the protective gloves and open the printer cover.



9. On the front of the print block, loosen the screws that secure the cover 
protecting the print-head driver cards. 

10. Lift up the cover.
11. Loosen the screws that secure the driver-card bracket, and lower the 

bracket.



12. Release the driver-card support.

13. Remove the driver card by releasing the latch at the points shown.



14. Release the upper and lower screws that secure the print head in the 
block. (If necessary, you may use a 4-mm hex (Allen) key to loosen the 
screws.)



15. Press down on the upper and lower locking screws to release the print 
head, and remove it from the bottom of the print block.

16. Make sure that along with the head, you remove the four (4) rubber O-
ring seals.



17. Place four (4) O-ring seals in the replacement head (see Figure 4-90 on the 
previous page).

18. Position the head in the print block, making sure that the location pins 
are in place. 

19. Tighten the upper and lower screws that secure the print head in the print 
block (see Figure 4-89 on the previous page).

20. Insert the driver card into its socket, and secure the card.

21. Lower the protective cover and tighten the screws to secure it.



22. In the Replace print heads screen, select the check box to confirm that 
you have replaced the head(s), and click .

23. With your fingers, make sure that the new head is level and even with the 
other heads.

24. Confirm that the heads are level by selecting the check box in the 
following wizard screen, and click .



25. In the next wizard screen, confirm that you have removed all tools and 
objects from the printer.

26. Close the printer cover.

The wizard continues by heating the heads, then filling and purging them. 
If there are no installation problems, the optimization procedure begins, 
to calibrate the print heads to the best working configuration—see 
"Optimizing (Calibrating) Print Heads" on page 4-51.   

If installation problems are detected, the wizard alerts you and instructs 
you how to continue (see "Installation Problems" below).

27. After replacing print heads, you should check the head alignment before 
using the printer to produce models. In the final wizard screen, select 

 and click  to run the Head Alignment wizard.

If the printer detects that there is a problem after you install print heads, a 
relevant warning screen appears.

➢  If the printer software does not detect the replaced head, release the print 
head card and re-insert it. (see "Removing the Defective Head" on page 4-
62). 



➢  If the replacement head was not calibrated by Stratasys, remove the head 
and replace it with another one. 

Contact your Stratasys service provider about the uncalibrated head.

The level of UV radiation from the lamps used for curing models can change 
over time. To ensure optimum curing of models during printing, a pop-up 
message reminds you to test the lamps and calibrate the level of UV radiation 
after every 300 hours of printing. You do this by running the UV Calibration 
Wizard.

To measure the UV radiation, you need:
• Stratasys TOL-03005-S (UV sensor and cable)

or—

• a stand-alone UV radiation meter, approved for use with the printer

The wizard compares the measured radiation to the recommended radiation 
level for each of the lamps, at each printing mode—High Speed / 
High Quality. 

When calibrating the lamps, the wizard attempts to adjust the radiation level, 
if necessary.

• If the reading is within the acceptable range, the wizard continues to the 
next phase. 

• If further adjustment is necessary, the current phase is repeated. 
• If the level of UV radiation is too low to be properly adjusted, the wizard 

continues to the next phase, but the final wizard screen indicates that the 
lamp’s radiation for the printing mode is unacceptable.







1. Start the UV Calibration Wizard from the Options menu.

2. In the following screen, select to adjust the lamp’s 
radiation level to the acceptable range.

3. In the following screen, select the UV sensor and measuring device to be 
used.



4. Make sure that the build tray is empty. Confirm this in the wizard screen 
and click .

➢  When using a Stratasys UV sensor box that you connect to the printer 
(TOL-03005-S), continue with "UV Sensor Connected to Printer" on the 
next page.

➢  When using a stand-alone UV radiation meter, continue with "External 
UV Meter" on page 4-73.



The following steps apply when using the Stratasys UV sensor box that you 
connect to the printer. They do not apply when using a  UV external radiation 
measuring device.

1. To synchronize the wizard and the UV sensor, enter the CF number from 
the label on the back of the UV sensor box.

2. Click .

The build tray lowers so you can connect the UV sensor box.



3. Connect the UV sensor cable to the connector in the printer.

4. Confirm the items listed in the wizard screen and click .

Continue with "UV Measurement        " on page 4-75.

The following steps apply when using a stand-alone UV meter. They do not 
apply when using the Stratasys UV sensor box connected to the printer.

1. When the following screen appears, open the printer and place the UV 
sensor (probe) at the rear edge of the tray, in the center.



2. Lead the cable out of the printer so that you can close the printer, and 
tape it down to make sure that it does not interfere with the moving print 
block.

 

3. Close the printer, while checking that the sensor does not move out of 
position.

4. Set the UV meter to measure mJ/cm2.

5. Set the range on the meter to 2,000.

6. Connect the cable from the sensor to the UV meter. 

7. Turn on the UV meter, and wait until “0 0 0.0” appears on the display.

8. In the wizard screen, confirm that the sensor is positioned correctly, and 
click .

Continue with "UV Measurement        " on the next page.         



The UV lamps power up and stabilize. (This takes several minutes.) Then, the 
print block passes over the sensor and the wizard compares the measured 
radiation to the recommended level for each UV lamp and printing mode. 
During this process, which takes 20–40 minutes, you need to monitor the 
progress as displayed in the wizard screen.

When using a stand-alone radiation meter, reset the meter and enter the 
reading (measurement) when you are prompted to do so.

 

If the UV level measured is not acceptable, the wizard calibrates the UV lamp 
by adjusting the current supplied to it, and then tests it again.

When all UV tests have finished, the results are displayed, showing the 
condition of the lamps after calibration (see Figure 4-110 below).



1. Click .

2. Remove the UV sensor and close the printer cover. After confirming the 
items listed in the wizard screen, click .

If the results are not acceptable for quality printing, this is indicated in the 
final wizard screen.

3. In the final wizard screen, click .

Load cells are sensors that measure the weight of the material cartridges and 
the waste container in the printer. It is important that you periodically check 
that the weight measurements are accurate to prevent unnecessary waste of 
printing materials. It is recommended that you calibrate the load cells once a 
month.

1. Start the Load Cell Calibration wizard from the Options menu.

2. In the following screen, select one or more load cells that you want to 
calibrate. 

3. Remove each selected cartridge from the materials cart, and click .



4. In the next wizard screen, observe the numbers and wait until the weight 
level is relatively stable—two units above or below the average level shown.

5. Select the check box, and click .

6. Click  in the final wizard screen.



The tubes that pump waste material from the roller waste collector and the 
purge unit should be replaced after 1500 hours of printing. At this time, a 
counter should display a maintenance message on the printer interface 
screen. 

You can verify that the pump tubes need to be replaced by examining the 
waste pump maintenance counters. 

➢  Click on the "Maintenance Required" indicator.

or—

➢  From the Options menu, select .



When the Maintenance Counters screen opens, scroll down to the General 
Pumps section.

The waste-pump tubes that require replacing are displayed in red.

To replace pump tubes, you replace the "cassette" assembly that attaches to 
the pump in the printer. Replacement cassettes are supplied in the printer 
Start-up Kit. Additional cassettes can be ordered from your Stratasys service 
provider.

1. Make sure that the printer is in Idle mode (see the figure on page 4-4).

2. Using an 8-mm hex (Allen) key, open the two latches that secure the left 
printer panel (as you face the printer).



3. Open the panel and disconnect the ground (earth) wire.

4. Remove the panel.

5. Identify the waste pump that requires tube replacement.



6. Unscrew the fittings that connect the waste tubes to the pump.

7. Remove the part of the fitting remaining on the pump tube, and save it.

8. When the tubes on both sides of the pump are disconnected, rotate the 
pump "cassette" assembly counter-clockwise and remove it.

9. Install a new pump cassette.

The new cassette contains a new pumping tube.

10. Connect the waste tubes to the new pump cassette.

11. If necessary, replace the pump cassette on the other waste pump.

12. Open the Maintenance Counters screen, scroll down to the General 
Pumps section, and click  for the relevant counter(s) (see the figure  
on page 4-30).

13. Connect the ground wire to the printer panel and attach the panel to the 
printer.



Filters are installed in the lines that supply Model material  to the print heads. 
To ensure that the heads remain in optimum condition, the filters are 
replaced by your service provider, as part of the scheduled maintenance 
routine. However, filters used for certain materials need to be replaced more 
often. A counter keeps track of the amount of material passing through the 
filters, and the Maintenance Required indicator appears in the printer 
interface when it is time to replace a filter. The counter for RGD515 material, 
for example, is set to notify you after 20 hours of use. This is enough, on 
average, for about a year of printing.

To check the material-filter counters, open the Maintenance Counters screen 
(see "Maintenance Counters" on page 4-29) and scroll down to the Filters 
section.

The figure above shows that 21 hours of filter time have passed since the left 
filter was installed, and that it needs to be replaced.

1. Prepare the following tools and materials:

❒  8-mm hex (Allen) key

❒  protective gloves

❒  cleaning cloths or paper towels

❒  replacement 10-micron filters (supplied in the Start-up Kit)

2. Close the printer application.



3. Shut down the printer computer, wait 60 seconds after the monitor goes 
blank, and turn off the main power switch.

4. Using an 8-mm hex (Allen) key, open the two latches that secure the back 
of the materials cabinet and remove the back of the cabinet.

5. Locate the 10-micron filters, installed for the relevant material.

6. Put on protective gloves.

7. Disconnect the tube connected to the top (inlet) side of the material filter.

8. Make sure that the fitting at the end of the feed-tube remains attached to 
the tube. Re-attach it, if necessary. 

9. Cover the filter with a cleaning cloth (or paper towels) to absorb material 
spillage. 



10. Identify the inlet side of the new filter. This is the side showing the part 
number. A 6mm tube is connected to the inlet. (An 8mm tube is 
connected to the outlet.)

 

11. Attach the inlet side of the new filter to the disconnected tube.

12. Disconnect the old filter from the outlet (bottom) tube.

13. Discard the old filter.

14. Attach the disconnected tube to the new filter. 

15. Wipe the filters, tubes and surrounding area to remove material leaks and 
spills. 

16. Replace the back of the materials cabinet.



17. In the Maintenance Counters screen, click and then  (see 
Figure 4-122 on page 4-82).

If the printer exhaust is not connected to an external ventilation system, a 
built-in activated-carbon filter removes odors from printing materials. This 
filter should be replaced regularly (as necessary) to keep your working 
environment pleasant. This is normally done during the preventive-
maintenance service visit. 

The UV lamps used for curing models have a long, but limited, working life. 
You can test and adjust their effective power with the UV Calibration wizard . 
If you need to replace a UV lamp, follow these instructions: 

1. Make sure the printer is in offline mode.

The online/offline button at the bottom of the printer interface should be 
red. If not, click it to switch the printer to offline mode.

2. Start the UV Lamp Replacement wizard from the Options menu. 



3. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer, and click .

The axes move to the “home” position.

4. Select the UV lamp(s) to be replaced and click .

5. Disconnect the UV-lamp power connector and the UV heat fuse
connector.



6. Loosen the screw securing the UV lamp cover (A), and pull the cover up 
(B), then out (C).

7. Pull the UV lamp reflector out of the UV housing.

8. Inspect the new UV lamp reflector, and make sure that a black strip is 
attached to the inside of it. If not, install one—on the side of the reflector 
opposite (not next to) the print block.

9. Discard the old UV reflector and lamp.











10. Insert the new UV lamp/reflector unit into the housing, next to the print 
block.

11. Replace the UV lamp cover by inserting it into the slot on the bottom of 
the housing, and tighten the securing screw on top.



12. Reconnect the power and heat fuse connectors.

13. In the wizard screen, confirm that you have replaced the UV lamp(s) and 
that the black strip is attached, then click .

The wizard operates the UV lamps and checks if their power is within the 
acceptable range for each printing mode. 



After replacing a UV lamp, it is recommended that you calibrate its power 
for the various printing modes. The next screen allows you to continue to 
the UV Calibration wizard (see "Testing and Calibrating the UV Lamps" on 
page 4-69).



Perform the Dynamic Nozzle Test if you suspect that poor quality in printed 
models is caused by clogged or faulty nozzles in the print heads—even if this 
is not indicated by the Pattern Test. 

The Dynamic Nozzle Test prints eight (8) samples on the build tray, which 
you can then visually inspect. Printing the samples takes about 20 minutes.

1. Make sure that the build tray is clear (empty).

2. From the Options menu, select , and then select the 
appropriate test for the current printing mode.

3. Check if there are gaps in the printed samples.

…………

❒  In the left sample shown above, there are no gaps. 

❒  In the right sample shown above, there are only two gaps, which is 
acceptable. 

Many gaps in the sample indicates that many nozzles in the print head are 
not functioning. This might indicate the need to replace the defective 
head. In this case, consult with your Stratasys service provider.



The printer application contains a suite of tests for regularly checking the 
hardware and software, and for troubleshooting. 

Because running the tests affects the operation of the printer, you can only 
open the Built-in Tests interface when the system is not printing.

The test suite features:
• The organization of printing-related tasks in categories:
❒  Communications 
❒  Data cards 
❒  Temperatures 
❒  Voltages 
❒  Encoder repeatability 
❒  Print-head heating
❒  Print-head filling 

• A clear display of test results and the source of any failures, enabling you 
to determine if printing is possible or worthwhile. 

• The ability to monitor test results for specific components.
• Troubleshooting tips

Running these tests can help identify problems in the printer hardware and 
software. A large number of hardware defects (or near-defects) warns you of 
possible printing problems, either for current or future jobs.







• From the Options menu, select .
• Press .



The Built In Tests screen lists pre-configured tests, grouped by component 
categories. In this screen, you select and run tests, and the results are 
displayed.

Test Name
This column lists all of the tests, together with selection check boxes. 

Click the check boxes to select the tests you want to run. To remove a 
selection, click the check box again. To quickly select all of the tests in a 
component category, use the Group drop-down list at the bottom of the 
screen.

Group
This column shows the component categories for each test. 

This tells you which tests are run when selecting a category from the Group 
drop-down list at the bottom of the screen.

Status
This column shows the results of each test after you run it:



Test Selection Area
In the Test Selection area, at the bottom of the screen, you can quickly select 
or de-select tests by their characteristics:

➢  Click .

➢  Use the Save and View command buttons.

Click the command buttons, on the right side of the screen to perform the
following operations:

Run
Click to run the selected tests.

Reset
Click to clear previously run tests. This returns the status of each test to 
Unknown (?).

Save
Click to save a report that summarizes the tests run. The report is saved as an 
HTML file. You can save any number of reports for the tests you run; the 
name of the file saved is . By default, these files are 
saved in the printer installation folder, but you can save it in any other folder.

View
Click to display the latest test report that you saved. (You can view other test 
reports by opening the relevant files in your Web browser. To do so, open 
Windows Explorer, and double click the BITReport file.)



Close
Click to close the Built-in Tests screen.

On the right side of the screen, a symbol represents the combined results of 
all the tests run, using the symbols from the Status column.

The following table lists the name of each test in the Built-in Tests suite, 
together with its description and a possible reason for its failure. If you need 
assistance, contact your Stratasys service provider.

 





Printer waste contains partially cured polymeric material, collected during 
normal operation and maintenance of the printer. For safety and 
environmental reasons, this material is kept in a special leak-proof, disposable 
container. 

The container has a capacity of 10 kilograms of waste material—usually 
enough for several months of printer use. The printer application displays a 
warning message when there are 9 kilograms of material in the container, 
and stops the printing when the net weight reaches 9.5 kilograms. Above 9 
kilograms, the software does not allow you to start a printing job or activity 
until you replace the waste container. You can monitor the weight of the 
waste container in the Printer Indicators display in the printer interface. You 
can also visually inspect the level of waste in the container. To access it, see 
page 4-98.

➢  In the main printer interface screen, click the display toggle to view the 
printer indicators.



The waste container consists of a plastic container inside a cardboard box. 
You typically dispose of the entire waste container—including the box. 
Therefore, you must assemble a new box and insert a new plastic container 
before you can install it in the printer.

1. Assemble the cardboard box, making sure to punch out the perforated 
sections.

2. Place a new plastic container into the box.

1. Locate the door on the lower-left side of the printer.

2. Push in the top-center of the door to release the latch and open the door.

3. Carefully slide out the waste container to remove it from the printer.

4. Place the new waste container next to the full container.

5. Unscrew the cap securing the waste drain tube and connect it to the new 
container.

6. Close the full container with the cap supplied with the new waste 
container.

7. Close the new waste container box.
If necessary, use tape to hold it closed.

8. Position new the waste container in the printer.



9. Close the waste compartment door.



The painted exterior plastic panels of the printer has a durable finish, offering 
excellent chemical resistance to common cleaning materials. Follow the 
recommendations below when cleaning these areas of the printer. 
Acceptable Cleaning Agents

• mild soap solution 
• common household cleaners and window cleaners
• common commercial and industrial detergents, 5% solution in water 
• alcohol (ethanol, isopropanol), 10% to 40% solution in water

Wipe the exterior of the printer, using a soft cloth moistened with the 
cleaning solution.
Unacceptable Materials

• industrial solvents 
• cleaning agents containing hydrocarbons, ketones, esters and lacquer 

thinners
• spray disinfectants
• abrasives and agents which could wear away the panel finish

The transparent section of the cover is made of strong, acrylic material that 
screens out harmful UV radiation. Use extreme care when cleaning it to 
prevent the appearance of scratch marks.

1. Blow off surface dust.

Do not wipe the surface to remove dust; this might scratch the surface.

2. Prepare a 1-percent solution of mild dish-washing soap in water—about 
two teaspoons (10 ml) in a liter of water.

3. Soak a micro-fiber cloth in the solution.

Do not use paper towels, which can cause scratch marks.

4. Thoroughly wet the surface with the cloth. Do not wipe! 

5. Rinse the cloth with clean water. 

6. Absorb the solution from the acrylic surface with the cloth, without 
applying pressure.

7. If necessary, repeat to remove any remaining marks, or apply clean water 
to rinse the surface.

8. If the surface is still wet, you can dry it with a clean, micro-fiber cloth by 
gently wiping in one direction.
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After printing models, you should allow them to cool as much as possible 
before handling them. If additional models do not have to be produced on the 
printer, it is best to let the printed models cool in the printer, with the cover 
closed, as long as possible. 

1. Let the printed models cool on the build tray for at least 10 minutes. 

2. Very carefully, remove the models from the tray with a scraper or spatula 
(supplied in the tool kit), taking care not to pry or bend the model.

3. Place the models on a flat surface, and cover them with a cardboard box 
or paper hood.

This allows the models to cool slowly and evenly.

4. Let the models cool for several hours.

After printed models have cooled, the Support material must be removed. 
This can be done by different methods, depending on the type of Support 
material, the size of the model, how delicate it is, the amount and location of 
the Support material, and other factors. The methods described in this 
section refer to removing general-purpose Support materials from models, for 
most printing applications. Use this information as a guide, and adapt the 
methods (or a combination of them) for cleaning your models.

There are two types of Support material available:
• SUP705 (FullCure705), a gel-like Support material.
• SUP706, an easily removed Support material that dissolves in a solution of 

caustic soda and sodium metasilicate.

SUP705 (FullCure705) and SUP706 can be removed from printed models 
using the following methods, in this order:

1. by hand

2. water pressure (in a suitable cleaning unit)

3. SUP705: 1% caustic soda solution (recommended for a smooth finish)



SUP706: 2% caustic soda and sodium metasilicate solution

While wearing protective gloves, break away excess Support material on the 
outside of the model. For delicate models, use a toothpick, pin or small brush 
after dipping the model in water.

 
• For SUP705, after breaking away excess Support material, soak the model 

in a 1% caustic soda solution (see "Removing SUP705 with Caustic Soda" 
on page 5-4).

• For SUP706, after breaking away excess Support material, soak the model 
in a 2% caustic soda and sodium metasilicate solution (see "Removing 
SUP706 with Caustic Soda and Sodium Metasilicate" on the next page).

For most models, the most efficient way to remove Support material is by 
using a high-pressure water jet. One suitable system is the Balco WaterJet 
cleaning unit. This device is marketed by Stratasys.

To clean a model using this device, you place it in the chamber, and you 
manipulate it and the jet using the built-in, waterproof sleeves. A pump turns 
ordinary tap water into a high-pressure jet, and a wiper keeps the window 
clear.



Soak models in a 1-percent solution of caustic soda (sodium hydroxide) to 
remove Support material from difficult-to-reach areas and to give the model a 
smooth, clean finish. The amount of time you soak the model in the solution 
depends on how delicate it is and how much Support material needs to be 
removed, but it is typically between half-an-hour and several hours. In any 
case, you should remove as much Support material as possible before the 
caustic soda treatment, and rinse the model thoroughly (with a water jet) 
afterwards. 

Soak models in a 2-percent solution of caustic soda (sodium hydroxide) and 
sodim metasilicate (Na2SiO3) to remove Support material. The amount of 
time you soak the model in the solution depends on how delicate it is and 
how much Support material needs to be removed. Rinse the model 
thoroughly under running water afterwards. 



Models made with VeroClear (RGD810) have a slight yellow tint when 
removed from the printer. This is especially true for models printed with a 
glossy finish. The yellow tint fades naturally over time, but you can greatly 
accelerate this process by using a suitable photobleaching treatment.

As a rule, best clarity is achieved when parts are printed with a matte finish, 
and treated as explained below.

Photobleaching models involves exposing them to light. To achieve highly
controlled and predictable results, a professional illumination chamber is 
recommended. However, adequate results may be obtained using ordinary 
desk lamps fitted with suitable fluorescent elements.

Follow these instructions for photobleaching printed models.
• The fluorescent lamps should be rated 45W, 6500K.
• When using desk lamps, place the models in a container lined with 

aluminum foil. Use at least two lamps, more when treating models in a
large container.

• Arrange the models with enough space between them to allow light to 
reach all sides of each model.

• Verify that the ambient temperature around the models is approximately 
40°C (104°F). Higher temperatures may cause model distortion; lower 
temperatures may not produce satisfactory results. When using desk
lamps, you can achieve the required temperature by positioning the lamps 
approximately 10 cm (4 in.) above the models.

• Inspect the models after six hours of treatment. 
❒  For parts with a matte finish, this should be enough. Polish and 

lacquer the parts.
❒  For parts with a glossy finish, continue the photobleaching treatment

for up to 18 hours more.

In Stratasys laboratories, there was a tint reduction of approximately 70%
within six hours. After 24 hours, tint was reduced by approximately 90%.



Models are cured as they are printed, making them safe and stable for a long 
time. However, proper storage conditions are necessary to prevent deforming.

• Keep printed models at room temperature and in a low-humidity 
environment.

• Do not expose models to direct sunlight and other heat sources.


